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WHAT'S ON THE DISC

Here is an overview of the contents of the Classroom in a Book disc

The Adobe Creative Suite 6 Production Premium Classroom in a Book disc includes
the lesson files that you'll need to complete the exercises in this book, as well as

other content to help you learn more about Adobe Creative Suite 6 Production

Premium and use it with greater efficiency and ease. The diagram below represents
the contents of the disc, which should help you locate the files you need.

These same disc files are available to eBook users via electronic download. Please

click here to go to the last page in your eBook for instructions.
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ADVANCED EDITING
TECHNIQUES

Lesson overview

In the previous lesson, you created a basic edit with Adobe Premiere

Pro CSé. In this lesson, you'll use more advanced editing techniques

and learn how to do the following:

Create simple dissolve transitions between clips in your Timeline
Apply and modify an effect to clips in your Timeline

Use an Adjustment Layer to apply multiple effects to multiple clips
Apply the Ultra Key effect to create a green screen composite
Create a static title with the Abobe Premiere Pro title tool

Use the Warp Stabilizer effect to smooth unsteady camera
movement in a clip

Generate a preview render of your Timeline

This lesson will take approximately 90 minutes to complete.
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A video clip that has been chroma keyed in Adobe
Premiere Pro CSé6.




Versioning your edit

If you are continuing from the previous lesson, feel free to continue with the Adobe
Premiere Pro project you already have open. If you are starting at this lesson, navi-
gate to the Lesson 04 folder on your hard drive and open the Adobe Premiere Pro
project Lesson_04 Start.prproj. Save your Adobe Premiere Pro project file in the
Lesson 04 folder as Afrolicious Promo.prproj.

Because you are continuing with a previous version of this edit, you'll first save a
new version of your sequence. This allows you to go back to the original version if
need be and is a recommended best practice in the video editing workflow.

1 In the Project panel, twirl open the Sequences bin.

Tip: Press 2 Click on the Afrolicious Promo Edit 01 sequence to select it. Choose Edit >
Command-+C (Ctrl+C) Copy to copy it to your clipboard. Then choose Edit > Paste.
to copy; press
Command+V (Ctrl+V) This will make a duplicate of this sequence outside of the Sequences folder.
to paste.

3 To modify the name of the sequence, click on the name of the sequence to
select it.

4 Change the name of the sequence to Afrolicious Promo Edit 02, press Return
(Enter) and drag it into the Sequences folder.

-

| Frame Rate

Afrolicious Promo Edit 021 |

Afrolicious Promo Edit 02
Sequence, 1280 x 720 (1.0)
00:01:16:20, 23.976p
44100 Hz - Stereo
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5 Double-click the Afrolicious Promo Edit 02 sequence to load it in your Timeline.

00:00:00:00

IJTIJ||LIv! (TLIv!TIJv!TI.iv-TIJv! q-l.ivz DTl.lvzTthTuvnTuvauwTumlelejmThv! Tuw- lTlez 14| Live_1%[ Live| Live_{Live | Live_24-60.mp4
H AT Lt (i

Can't_Listen_Edited_Even.aif

Note that the sequence appears in a new tabbed Timeline panel in front of your
original sequence.

Having multiple Timeline panels open simultaneously can be useful in certain
situations, but it can also be confusing. For the time being, you'll close the
first Timeline to eliminate the possibility of accidentally modifying the wrong
sequence.

6 In the Timeline panel, click the Afrolicious Promo Edit 01 tab to select it.

7 Press Command+W (Ctrl+W) to close this sequence. You can also click on the x
in the corner of the tab to close it.

The new sequence is now the only one visible in the Timeline, which will ensure
that you are working on the most recent iteration.

Adding transitions

In the previous lesson, you created a basic edit containing “hard cuts,” meaning that
each clip cuts directly into the next. In many instances, you can move between cuts
more gracefully with a transition. A transition can serve as a storytelling device to
indicate the passage of time or a change of location.

The most commonly used transition is a dissolve, which blends the tail of one clip
with the head of the next clip. The term dissolve dates back to traditional film
editing where the frames of celluloid were literally dissolved together in a chemi-
cal bath to merge them together. With Adobe Premiere Pro, you can add a dissolve
simply by clicking and dragging.
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Because the first few clips in the edit happen over a calm portion of the music,
transitioning between them with dissolves will help give a calmer feeling to that
portion of the edit. Let’s add those dissolves now.

1 Click on the Timeline panel, and then press the backslash (\) key to zoom your
sequence to fit the Timeline panel.

2 Drag the current time indicator (CTI) to the beginning of the sequence, and
then play back the first 10 seconds of the edit.

At about 9 seconds, the music track starts to pick up energy, and the existing
straight cuts will work well from that point forward. For the edit points before
9 seconds, you'll add a dissolve.

3 Press Shift+7 to open the Effects panel.

4 In the search field, type dissolve.

126 LESSON 4 Advanced Editing Techniques



Note that as you type, Adobe Premiere Pro filters out the list to show you only
those effects containing the text you are typing. In this case, you'll see the
dissolve effects after typing the first few letters; it is not necessary to type the
entire word dissolve.

Also, note the yellow square around the icon for Cross Dissolve. This yellow

square indicates that this transition is set as the current default Video Transition.

Make sure that the Track Header for Video 2 is highlighted in the Timeline.

If it is not, click it. Doing this will ensure that transitions will be applied to
clips in this track when using the Apply Video Transition keyboard shortcut or
menu command.

b Video 2

¥ Video 1

In the Timeline, hold down the Shift key and scrub the CT1 so it snaps to the

first edit point, which is between the clips Live_25-60.mp4 and Live_23-60.mp4.

Zoom in by pressing the equal (=) key on your keyboard (not the numeric keypad).

Drag and drop the Cross Dissolve effect from the Effects panel onto the edit
point on your Timeline. You can also use the Apply Video Transition keyboard
shortcut, Command+D (Ctrl+D). Verify that the transition overlaps both clips.

Use the Play Around shortcut (Shift+K) to automatically adjust your CTI two
seconds before the current frame (or preroll), and then play two seconds after
the current frame (or postroll). This allows you to preview your transition.

Next, you'll add a transition at the beginning of the edit so it fades in from
black. This will make for a more graceful start to the piece.

Because you'll be applying a similar transition as before, you can copy that
Cross Dissolve that you just made and paste it here.

Tip: To change the
default transition, right-
click on a transition
in the Effects panel,
and then choose Set
Selected as Default
Transition from the
context menu.

Tip: You can zoom
in on your Timeline
using the equal (=) key.
Zoom out by using the
minus (-) key.

Tip: Change the
preroll and postroll
values in the Playback
preferences to set how
many seconds before
and after the current
frame that Adobe
Premiere Pro will play
back after pressing
Shift+K.
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10 Select the transition clip between Live_25-60.mp4 and Live_23-60.mp4. Press
Command+C (Ctrl+C).

11 Press Home to adjust your CTI to the beginning of the sequence. Press
Command+V (Ctrl+V) to paste the transition.

12 Press Shift+K to play back the first few seconds.

Note that the video in Video 1 is visible during the transition. Because you are
only using the audio from Joey’s interview, not the video, you'll toggle off the
visibility of Video 1.

13 Click the Toggle Track Output button on Video 1.

ofi 1
& o,

14 Go to the beginning of the sequence and play back the first few seconds.

Now the video fades in from black. Next, you'll modify the duration of the
transition so it lasts one second.

15 In the Timeline, double-click on the transition clip.

Doing this will show the Effect Controls for the transition, which shows the
duration is currently 12 frames.
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16 Click on the duration value to make it editable. Type 100 and press Return
(Enter). Notice that Adobe Premiere Pro translates 100 to 00:00:01:00.

Duration  FVIH

17 Play back your changes to review them.

The most-used transitions

As tempting as it might be to use the video transitions with wild abandon, in terms
of style, it's probably not a good idea. Apart from a standard cut transition, only a
few video transitions should even be considered unless there are special project-
specific circumstances:

e A Cross Dissolve fades out clip A while fading in clip B. Cross Dissolves can also
work well at the beginning or end of a clip when you want to fade in or out from
black. A Cross Dissolve can indicate passage of time or a change in location to
the viewer.

* A Wipe transition replaces clip A with clip B by revealing clip B in a linear or
radial fashion. A Wipe is generally used to indicate a change in location.

* An Additive Dissolve functions much like a Cross Dissolve. However, in an
Additive Dissolve, the luminance values of clip A and clip B are gradually
added together so that at the halfway point of the transition there is a peak of
brightness. This makes the transition a bit more noticeable and stylized than a
Cross Dissolve.

Creating effects in Adobe Premiere Pro

Adobe Premiere Pro CS6 comes bundled with several dozen effects that enable you
to perform simple and complex tasks, such as color correction, blurring and sharp-
ening, audio enhancement, texturing, chroma keying, and a variety of other effects
to enhance your edit. Having the ability to apply effects to clips in Adobe Premiere
Pro yields efficiency in your workflow, because you don'’t always have to use another
program, such as Adobe After Effects, to create visual effects for your edit.

The most relevant and most important use of effects by far, for most editors, is the
ability to adjust contrast and exposure, and make color correction enhancements.
The Three-Way Color Corrector effect in Adobe Premiere Pro CS6 has been greatly
enhanced and will be covered in Chapter 8.
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Tip: Double-click
to apply an effect to a
selected clip, or series
of selected clips.

Let’s do a simple exercise that demonstrates some of the general rules about effects
in Adobe Premiere Pro CS6. You'll apply multiple effects to a clip to give it an “old
film” look, and then save those effects and their settings as a preset.

Applying an effect to a clip

First up is applying a simple effect to a clip. You'll apply the Black & White effect in
this exercise.

1 Press Shift+7 to access the Effects panel. You need to find the Black & White

effect, which desaturates a clip.

2 In the search field, type the word black, which will reveal all effects with that
word in their names.

Select the Black & White effect, and drag it onto the first clip in your sequence,
Live_25-60.mp4.

Press Shift+5 to access the Effect Controls panel of this selected clip. The Black

& White effect is a very basic effect and has no controls.

Video Effects
i+ Motion

yacity

Time Remapping

£ Black & White

Now let’s give this clip a bit of sepia tone. In the Effects panel, type tint in the
search field.

Select the Tint effect and drag it onto Live_25-60.mp4.

Change the Tint settings so black is mapped to orange.
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7 In the Effect Controls panel, click on the Map Black To color swatch. In the
Color Picker, choose a fully saturated bright orange, and then click OK.

AOL68 Color Picker

8 In the Tint Effect Controls panel, set Amount to Tint to 25%.

The clip should now look sepia toned.

Changing render order of effects

The top-to-bottom stacking order of effects in the Effect Controls panel determines
their rendering order. Currently, Black & White is stacked above Tint; therefore,
Black & White renders and then Tint renders. You can change the rendering order
by adjusting the stacking order of effects.
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1 In the Effect Controls panel, select the Tint effect. Drag it above the Black &
White effect.

Notice that the clip is no longer sepia toned as before. The reason is that the clip
is being tinted, and then the result of that is made black and white.

2 Press Command+Z (Ctrl+Z) to undo this last action.

Copying and pasting effects

You can copy and paste effects between clips in the Timeline. Doing this can ulti-
mately save you time if you need to apply the same effect(s) with the same setting(s)
on multiple clips.

1 Select the Black & White effect in the Effect Controls panel. Hold down
the Command (Ctrl) key and select the Tint effect. Both are now selected.
Press Command+C (Ctrl+C) to copy.

2 Inyour Timeline, select the Live_23-60.mp4 clip. Press Command+V (Ctrl+V)
to paste.

3 Press the Home key, and then press the spacebar to play your sequence from the
beginning. The first two clips in your sequence now appear sepia toned.

The first two clips in your sequence have these two effects applied to them. But
what if you wanted to apply these effects to all of the clips in your sequence?
You could copy and paste these effects to each clip in your sequence. However, if
you changed the effect settings on one of the clips to maintain consistency, you
would then have to change the settings on all other clips, which would be tedious
and time-consuming. There is a better way and that’s by using adjustment layers.

Adjustment layers

Adobe Premiere Pro CS6 now features Adjustment Layers, which are special layers
that allow you to apply one or more effects to several clips at the same time using
the same effect settings. Let’s see how these Adjustment Layers work.

1 Press Command+Z (Ctrl+Z) to undo pasting the effects to Live_23-60.mp4.

2 Click the Project panel tab. Make an Adjustment Layer by choosing File > New >
Adjustment Layer.
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3 In the Adjustment Layer window that appears, make sure that the settings

match your sequence settings. The Width should be 1280, the Height should
be 720, the Timebase should be 23.976 fps, and Pixel Aspect Ratio should be
Square Pixels (1.0). Click OK.

Adjustment Layer

This new Adjustment Layer should appear in your Project panel.

Adjustment Layer

» BB Audio
» BB Interview

Select this Adjustment Layer and drag it into your Timeline, on Video 3, so its
head snaps to the beginning of the sequence.

Adjustment Layer

(N Cross Dissolve ‘ Live_25-60.mp4

dis and drummers [V] Opagity Opacity =

[of{+T2 9 IE Live_23-60.mp4

2 ¥ Video 1

=

By itself, the Adjustment Layer is not visible. However, if one or more effects are
applied to the Adjustment Layer, those effects are rendered on the clips in the
track(s) below the Adjustment Layer.

Now let’s apply the Black & White and Tint effects to the Adjustment Layer.
You can cut them from the Live_25-60.mp4 layer and paste them onto the
Adjustment Layer. In this example, you don’t want the effects on the video clip
if they will be applied to the Adjustment Layer.

Select Live_25-60.mp4 in the Timeline. Press Shift+5 to access its Effect
Controls panel.

Select the Black & White effect. Hold down the Command (Ctrl) key and select
the Tint effect.

dis and drummers [V] Opacity:Opacity -

Note: If a binis
selected in your Project
panel when you create
an Adjustment Layer,
the Adjustment Layer
will appear inside
the selected bin. The
Adjustment Layer can
then be dragged else-
where in the Project panel.
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8 Press Command+X (Ctrl+X) to cut the effects from the video clip.

In your Program Monitor, notice that the effects are not rendering on
Live_25-60.mp4 anymore.

9 In your Timeline, select the Adjustment Layer. Press Command+V (Ctrl+V) to
paste the effects.

10 Scrub the CTI in your Timeline to Live_23-60.mp4. Notice that the effects
applied to the Adjustment layer render on it because the clip is in a track below
the Adjustment Layer.

Now that these two effects are on the Adjustment Layer, you can extend the tail
of the Adjustment Layer to render the effects on more clips in Video 2.

11 Show your entire sequence in the Timeline by pressing the backslash (\) key.

12 Select the tail of the Adjustment Layer and drag to the right so the Adjustment
Layer covers more clips in Video 2.

Adjustment Layer,

13 Scrub your CTI forward in the Timeline to verify that more clips in Video 2 are
now sepia toned. Because the Adjustment Layer is a single clip, you need to
adjust only its Effect Controls to modify how its effects render on all clips in the
track(s) below it.
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Saving and exporting presets

Effects and their settings can be saved as a preset, which allows you to easily apply
the effects and their settings on clips in your Timeline without having to copy and
paste them between layers. Also, because presets can be saved as files on your hard
drive, they can be copied between different computers and applied by other users
in Adobe Premiere Pro CS6. Let’s save and export a preset now.

1 Select the Adjustment Layer in your Timeline. Press Shift+5 to access the Effect
Controls panel.

2 Select the Black & White Effect, and then hold down the Command (Ctrl) key
and select the Tint effect.

3 Right-click on either of these effects and choose Save Preset.

Save Preset

4 In the Save Preset window that appears, type Old Film in the Name field to
name the preset. Click OK.

5 To verify that this preset works, press Delete to remove the two selected effects.

6 DPress Shift+7 to access the Effects panel. Select any text that may be in the
search field and press Delete.

7 Click the disclosure triangle next to the Presets folder to twirl it open. You
should see a preset called Old Film.

8 Select this preset, and then drag it onto the Adjustment Layer in the Timeline. Note: Presets can

The saved effect settings are once again applied to the Adjustment Layer. also save settings for
Motion and Opacity.
This exercise was just a demonstration. You really don’t want to use this old-film

look or this Adjustment Layer in your sequence, so let’s modify the sequence now.
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9 In the Project panel, select the Adjustment Layer, and then press Delete. Click
Yes in the warning window that appears to confirm that you want to remove the
Adjustment Layer from the project.

The Adjustment Layer should no longer be in your Timeline.

10 Press Shift+7 to access the Effects panel again. Notice that the Old Film preset is
still there and could be utilized later if desired.

But it can also be exported and shared with other users.
11 Right-click on the Old Film preset and choose Export Presets.

12 In the Export Presets window, navigate to your Lesson 04 folder. Save the Preset
as Old Film and click Save.

Third-party effect plug-ins

In addition to the effects that come bundled with Adobe Premiere Pro, many third-party effect plug-ins can be
installed separately. These third-party effect plug-ins are useful because sometimes the features available with
native Adobe Premiere Pro effects are insufficient for your project’s needs. Third-party effect plug-ins are some-
times available as a free download from the Internet, but there are also some popular effects that are available
as a separate purchase. Often, third-party effect plug-ins for Adobe Premiere Pro are also available for Adobe
After Effects.

Here is a short list of third-party effect plug-ins that are available for Adobe Premiere Pro CS6:
Red Giant Software (www.redgiantsoftware.com)

e Magic Bullet Suite is a bundle of color-correction effects that enable you to easily color correct and add
different grades to your project. The suite also includes Colorista I, a professional color-grading tool, as well
as multiple presets for Magic Bullet Looks.

e Trapcode Shine, as the name suggests, enhances the luminance of a clip by creating the visual effect of
bursting light. This is useful, for example, in adding style to text or for creating interesting science fiction
visual effects.

Digieffects (www.digieffects.com)

e Delirium is a bundle of 45 different effects for generating particles, performing color correction, distorting
and displacing, and enhancing Premiere Pro’s compositing capabilities.

e Damage is a bundle of various effects for making your clean video footage look degraded and aged.
Boris FX (www.borisfx.com)

e Boris Continuum Complete AE is a bundle of over 200 effects for image restoration, color correction,
3D particle effects, blurs, glows, and more.

For more information on third-party effect plug-ins for Premiere Pro CS6, go to www.adobe.com/products/
premiere/extend.displayTab4.html.
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Keying and compositing
green screen footage

One of the most useful techniques to learn in video postproduction is convincingly
inserting a subject recorded in front of a green (or blue) background into a scene,
thereby creating the illusion to the viewer that the subject is actually part of that
scene. The most common and effective method of achieving this effect is called
chroma keying.

The typical workflow for chroma keying starts by recording the subject in front of
an evenly-lit green or blue background. After importing the footage into Adobe
Premiere Pro, you remove the background with a Chroma Key effect (and some-
times a garbage matte), which enables the compositing of the subject with another
shot or scene. This technique is used on a range of media—from major motion
pictures to the weather report on your local TV news.

How easy or difficult it is to pull a “clean key” (which is essential to achieve a con-
vincing final result) depends on a variety of factors having to do with the quality of
the footage:

* Was the background evenly lit? Proper lighting while shooting green screen
footage is crucial. Chroma Key effects work by sampling the color of the green
screen and then making that transparent. If the green screen was not evenly lit,
it will appear as more than one shade of green. Therefore, sampling one area of
the green screen will not make the whole green screen transparent.

*  Was the footage recorded in a video format optimal for chroma keying? You
should record your green screen footage at the highest resolution possible and
with minimal compression, so that the foreground subject has smooth edges
and no image artifacts.

* Was the foreground subject semitransparent? If your foreground subject has
long flowing hair or is wearing semitransparent clothing, the color of the green
screen showing through the semitransparency will not be consistent with the
unobstructed areas of green screen in frame and will result in more time spent
pulling a clean key.

These and other factors will determine whether you can achieve a satisfactory
result with a single click, or if you'll need to make some adjustments to get the look
you want.
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Creating the garbage matte

In some green screen footage, you can remove objects in the shot by simply crop-
ping out that part of the frame. This is known as creating a garbage matte.

In the following exercise, you'll include a green screen shot in the edit and apply a
Chroma Key effect to it. Then you'll composite another clip in a video track below
the Chroma Key clip that will show through the transparency.

1 In the Project panel, twirl open the Joey bin and find the clip Joey_01.mp4.
Double-click on this clip to display it in the Source Monitor.

2 Play the entire clip.

Don't use the beginning of the clip when the camera zooms out. Instead, trim
the clip to the desired segment.

3 In the Source Monitor, adjust the CTI to 0:00:07:00 and press the I key to set
this clip’s In point. Adjust the CTI to 0:00:09:23 and press the O key to set this
clip’s Out point.

4 Click the Drag Video Only icon at the bottom of the Source Monitor, and then drag
this trimmed clip into the Timeline on track Video 3 so the head of the clip snaps
to the marker at 0:01:01:04. You want to leave a gap in Video 2 directly below.

Drag Video Only 9

5 In your Timeline, adjust your CTI to just before this clip. Press the spacebar to
play the sequence.

Notice that at the end of the shot the camera pans left, and you see the corner of
the wall behind the green screen. You'll remove this extraneous object from the
shot by creating a garbage matte.
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6 Press Shift+7 to make the Effects panel active.

7 Type crop in the search field to quickly locate the Crop effect.

8 Select the clip on the Video 3 track in the Timeline, and then double-click the Note: Double-
Crop effect to apply it. clicking to apply an
effect to a selected clip
9 Press Shift+5 to open the Effect Controls panel. is a new feature in CS6.

10 In the Effect Controls panel, click the Crop effect to select it.

Notice that in the Program Monitor you can now see a bounding box around
the video frame with handles on the top, bottom, left, and right.

11 In the Timeline, scrub the CTI to the end of the Joey_01.mp4 clip when the wall
behind the screen is most visible in the frame.

12 In the Program Monitor, drag the left handle of the bounding box to the right
until the wall in the upper-left corner of the frame is no longer visible.

00:01:05:02

13 In the Effect Controls panel, click in the empty space below the Crop effect to
deselect it.

Now let’s add a clip to Video 2. Once the green screen in Joey_01.mp4 is
chroma keyed and thus transparent, you want to have something that shows
through the transparency.

14 In the Project panel, twirl open the Live bin and find the clip Live_26-Lights.mp4.
Double-click on the clip to open it in the Source Monitor. Press the spacebar to
play the clip. This is what will appear behind Joey.
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15 Drag Live_26-Lights.mp4 into the Timeline on track Video 2, directly below
Joey_01.mp4 so the head of Live_26-Lights.mp4 snaps to the head of Joey_01.mp4.

16 Click the Selection tool and trim the tail of Live_26-Lights.mp4 so it lines up
with the tail of Joey_01.mp4.

Jacity:Opacity =

-00:00:01:15

In the Program Monitor, you should see Live_26-Lights.mp4 through the
cropped area of Joey_01.mp4.

00:01:04:03

UL

Next, you'll apply a Chroma Key effect so that the green background of Joey_01.mp4
is transparent.
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Using Keylight in
Adobe After Effects

For doing basic green screen composites that include a simple video background,
the Ultra Key effect in Adobe Premiere Pro CS6 is usually sufficient.

However, for those times when the Chroma Key effects in Adobe Premiere Pro are
insufficient for the needs of a challenging green screen composite, you can use the
Keylight keying effect in After Effects CS6. In addition to offering more sophisticated
control of a clip’s alpha channel, it has its own color-correction and edge-cropping
controls as well. Also, if you are using After Effects to do chroma keying, you could also
use the masks, mattes, and layer modes that make After Effects an industry-standard
compositing application.

Applying the Ultra Key

The Ultra Key is a Chroma Key effect that makes it easy to pull a “clean key” from
footage shot with a green screen background. You'll first define the background
color and then make some minor adjustments that will make Joey appear as if he is
part of the background on the Video 2 layer in the Timeline.

1 Select Joey_01.mp4 in the Timeline.

2 Press Shift+7 to make the Effects panel active.
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3 Type ultra in the Search field to quickly locate the Ultra Key effect.
4 Double-click the Ultra Key effect to apply it.

5 Press Shift 5 to bring up the Effect Controls panel. Locate the Ultra Key effect
(it will be on the bottom of the stack) and click the Eyedropper to activate it.

v £ Ultra Key

Look at the shot in the Program Monitor and note that the green screen was not
lit evenly. The background is lighter on the right side of the frame and gradually
gets darker toward the left side of the frame. This is a common scenario that
editors have to deal with.

The best approach in this situation is to select a shade of green in the frame that
is approximately median luminance so that a maximum area of the green screen
background will be made transparent.

6 In the Program Monitor, click on a green value that’s halfway between the
lightest and darkest areas of green in the frame. In this clip it would be just to
the left of Joey’s face.

00:01:04:03 [Fir 1z ¥ A 00:01:09:04

(]
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The green background disappears from the frame, and you can see the
background clip on Video 1 showing through. However, it’s not a “clean key” yet
because you can still see some darkness in the background to the left where the
green screen was lit darker. Making some minor adjustments will fix this.

In the Effect Controls panel, locate the Ultra Key effect and change the Output
menu setting from Composite to Alpha Channel.

* Composite

Alpha Channel |.,
Color Channel

In the Program Monitor, you can now see the alpha channel, or transparency
information, of the clip. The black areas are transparent; the white areas are
opaque.

00:01:04:03 i /2 I+ % 00:01:09:04

The goal when you are adjusting the controls in the Ultra Key effect is to make
the entire background completely black while keeping the subject completely
white (with the exceptions of the edges of the subject, which should be halfway
between white and black to avoid a “hard edge” on the subject that can make
the composite look fake and unconvincing).
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8 In the Effect Controls panel, click the disclosure triangle next to Matte
Generation in the Ultra Key effect to reveal its properties.

¥ £ Ultra Key

9 Click on the value of the Pedestal property and drag it to the right until its value
is 100. As you drag, notice how the background becomes nearly entirely black
while the subject remains white.

In this case, adjusting the Pedestal property achieved a threshold for the key,
which made most of the green pixels transparent. But you'll still notice an area
in the upper-left corner of the background that has not turned completely
black. To finish the job, you need to adjust the Shadow property.

10 Click on the value for Shadow and drag it to the left until its value is 25 or until
the background area of the frame is completely black. As you drag, notice how
the remaining white pixels in the background fade to black.

00:01:04:03 i Tz v A 00:01:09:04
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11 Click on the Output menu and change the setting from Alpha Channel back to
Composite.

| 00:01:04:03 i Tz T A 00:01:09:04

Notice that the edge of Joey’s hat in the frame looks a bit too sharp. Because
Joey’s head is not actually flat, this edge sharpness looks unconvincing and
could use a bit of softening.

12 Twirl open the settings for Matte Cleanup and adjust the value for Soften to 50.

13 In the Timeline, drag the CTI to the beginning of the sequence, and then press
the spacebar to play it back.

Joey is now convincingly composited into the background.

| 00:01:04:03 it /2T A 00:01:09:04
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Had this clip been shot with an evenly lit green screen, the fine-tuning you just did
would likely not have been necessary. The reality in the world of film and video
production is that editors have to work with green screen footage recorded in a
variety of optimal, and not-so-optimal, situations. The good news is that with the
Ultra Key effect, it’s usually just a matter of selecting a “middle ground” color when
you start the process and then making some minor adjustments (like you just did)
to get the desired result.

Adding titles with the
Adobe Premiere Pro Title tool

Adobe Premiere Pro gives you the ability to create simple title clips that you can
add to your edit. These are typically used as onscreen text to identify a location or
someone who is speaking on camera. Although other applications in Adobe CS6
Production Premium, such as Adobe Illustrator or Adobe Photoshop Extended,
allow you to create text that you can then import to Adobe Premiere Pro, using the
native type engine in Adobe Premiere Pro can save you the trouble of switching back
and forth between applications, and having one more media file to keep track of.

The type engine in Adobe Premiere Pro is quite robust and can employ all kinds of
different fonts and presets for styles, as well as apply text on a vector path. Titles
can either be still or animated.

You'll create a simple static title clip to identify the nightclub that you see in the video.

1 Choose Title > New Title > Default Still. The New Title window appears. Leave
the current values for Width, Height, Timebase, and Pixel Aspect Ratio as is. In
the Name field, type Name of Club and click OK.

New Title
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The Titler will appear with a collection of panels, all of them related to title
design. A Tools panel contains a Selection tool and a Type tool along with Font
Family and Font Style fields, Font Size value, type alignment buttons, Spatial
Transform properties, and Type Color properties.

Also, a miniature monitor allows you to see how your title will look when
superimposed over the current clip in your Timeline. This monitor shows two
concentric rectangles that represent the action safe area (the outer rectangle),
as well as the title safe area (the inner rectangle). In most cases, you don’t want
to place titles on the edge of a frame. These rectangles provide a general visual
guide to ensure that the titles you create will reliably show in the final video
with a sufficient space buffer around them.

Click the Type tool in the Tools panel and click once in the Title Monitor. A Tip: Scrub the CTI
type field appears. Type Boku Room and press Return (Enter) to create a line in YO}"Time“n? when
break. Then type San Francisco, CA. Select this second line of type and reduce :zilg‘lz Egale; ';:I)Een
the Font Size value so that Boku Room is more prominent. Click the Selection will look over different
tool to commit your changes to the type. shots.

¥ Transform

Let’s apply a few more adjustments to the title.
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3 Press Command+A (Ctrl+A) to select all text. Click the Left Align button so the
type is left aligned. Set the Fill Type to Solid and set the Fill Color to white.

i‘ Left (Shift+Cmd+L)

4 As ageneral rule, when you're choosing a type font that will appear in a video,
choose an easily legible sans serif font. Set the Font Family to Helvetica Neue
and the Font Style to Bold. Click the Selection tool to commit the changes to

your type.

5 With the Selection tool, click once in the type box and drag it to the bottom left
of the title safe area.

| B | Z | ¥ Transform

= u B

LY LG AA N AA

Note: Ifabinis 6 Close the Titler panels.
selected in your Project
panel whenyyou creJate 7 In the Project panel you should see the Name of Club title clip. Drag this into
atitle clip, the title your Timeline on Video 3 so its head aligns with the In point of Live_02.mp4.
clip will appear inside With the Selection tool, click on the tail of the title clip and trim it so it aligns

the selected bin. The
title clip can then be
dragged elsewhere in
the Project panel.

with the tail of Live_02.mp4.
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8 Adjust the CTI to the beginning of the sequence, and press the spacebar to play.
You should see the static title clip composited with the video clip below it in
Video 2.

Boku Room
San Francisco, QA""

a3

v A, 00:01:09:04

Serif fonts vs. sans serif fonts

A serif is a typographic detail on the ends of some of the strokes that make up letters
and numbers. A serif leads the eye to the next letter, but they are only visible at high
resolutions, such as in print. When displayed with limited pixels, serif fonts can create
visual artifacts in video frames and thus affect legibility.

Sans serif fonts can sometimes look more modern and were developed specifically
to be used in electronic media. They feature even spacing between letters and even
thickness of the font elements, resulting in legible type onscreen.
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Stabilizing footage with the Warp Stabilizer

Now let’s look at a technique that will improve the look of your footage instantly.
While this may not seem like an “advanced” technique, it’s in this section because
performing this level of clean up makes your project look even more professional.
A common issue that occurs with footage recorded on handheld cameras is that it
can be shaky and uneven, making it difficult to watch. The Warp Stabilizer, intro-
duced in Adobe After Effects CS5.5 and now available in Adobe Premiere Pro CS6,
is an incredibly advanced stabilization tool that can make this type of footage look
as if it was recorded with a sophisticated camera rig.

What makes the Warp Stabilizer easy to use is its automatic analysis of the footage,
which allows for minimal customization. The advanced image analysis, which takes
place “behind the scenes” in Premiere Pro, does all the heavy lifting for you.

Sometimes, editors will encounter a video clip that is well composed but unsteady
and not favorable because the videographer did not hold the camera steady or an
isolated bump to the tripod occurred. In such situations, the video clip may still be
salvageable by removing the camera shake with the new Warp Stabilizer effect in
Adobe Premiere Pro CS6.

The Warp Stabilizer works by analyzing a shaky video clip and automatically apply-
ing motion to the clip to counteract the unstable motion in the raw clip.

Let’s apply the Warp Stabilizer to a clip in the sequence.

1 Find and select the clip Studio_03.mp4 in Video 3. This is a short clip of Joey
sitting at his recording studio workstation as he makes adjustments to an audio
recording. Notice that about halfway through the clip is a considerable amount
of camera shake, which would ordinarily make this shot unusable.

2 Press Shift+7 to make the Effects panel active.

3 Type warp in the Search field to quickly locate the Warp Stabilizer effect.
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4 Double-click the Warp Stabilizer effect to apply it to the selected clip.

The Warp Stabilizer effect immediately starts analyzing the clip, and a blue bar
across the image in the Program Monitor indicates that the clip is being analyzed.

00:00:43:12 i Tz v A 00:01:09:04

Progress analyzing the clip, in number of frames and percentage, is displayed in
the Effect Controls panel. When the analysis process is complete, an orange bar
appears across the image, indicating that it is being stabilized.
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6 When the stabilization process is complete, play the clip.

Notice how the camera shake is completely gone, and the pan from right to left
at the end of the shot is smooth and fluid, as if the camera had been mounted
on a tripod with a high-quality head. However, it must be mentioned that the
Warp Stabilizer zooms into the clip slightly, which can risk making it appear
soft. Scaling of up to 110% is usually acceptable.

In many cases (such as this one), you don'’t have to change any of the default set-
tings in the Warp Stabilizer effect to get a good result. If necessary, the effect has
multiple advanced settings to adjust clips with varying levels of shake.

Rolling Shutter Repair effect

In digital video cameras with CMOS sensors, video is recorded one scan line at a
time; therefore, not all video in a given frame is recorded at the same time. This can
cause a distortion called rolling shutter if the camera is moving quickly while record-
ing or if the recorded subject is moving quickly.

New in Adobe Premiere Pro CS6 is the Rolling Shutter Repair effect, which fixes this
distortion.

Rendering your timeline

If you are using Adobe Premiere Pro CS6 on a machine with a GPU that does not
support the Mercury Playback Engine, your playback may not be smooth and
uninterrupted. Premiere Pro can create preview renders, which are cached video
files on your hard drive that allow you to play back your edit in real time if playback
is not smooth.

During playback, you may see red and yellow bars at the top of your Timeline with

a gray bar above them. What do they mean?

The gray bar is called the Work Area bar. It defines the range of time in your
Timeline for which Premiere Pro will create a preview.
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The yellow bar(s) indicate source files that are computationally difficult. For exam-
ple, footage from a DSLR camera may yield a yellow bar in your Timeline. These
frames will sometimes play back in real time, but not always. That depends on the
speed of your computer.

The red bar(s) indicate clips that have effects applied to them or unrendered clips
from Adobe After Effects. These frames will most likely not play back in real time,
and need to be rendered.

Let’s generate a preview render of your Timeline.

1 Select your Timeline. Press the backslash key (\) to view your entire sequence.
2 Double-click on the Work Area bar so it includes your entire edit.

3 Choose Sequence > Render Entire Work Area.

You'll see a Rendering window with a progress bar indicating how much render

time remains.

Rendering : 58.26%

When the progress bar finishes, the yellow and red bars at the top of your

Timeline will be green, indicating frames that have been preview rendered.

4 Press Home and then press the spacebar to play your edit.

5 Press Command+S (Ctrl+S) to save your project.

ADOBE CREATIVE SUITE 6 PRODUCTION PREMIUM CLASSROOM IN A BOOK 153



Open workflows with other
applications, such as Final Cut
and Media Composer

As you work in Adobe Premiere Pro, you can collaborate more efficiently with col-
leagues by importing and exporting Apple Final Cut Pro and Avid projects.

Adobe Premiere Pro CS6 allows you to import and export a Final Cut Pro XML
project file but with certain limitations. For example, audio keyframes, blur effects,
color wipes, and cross dissolves all transfer intact from Final Cut Pro 7 to Adobe
Premiere Pro via XML 5.0, but the Three-Way Color Corrector doesn’t transfer cor-
rectly because Final Cut Pro processes color correction in RGB, whereas the Premiere
Pro Three Way Color Corrector processes it in YUV. Additionally, Final Cut Pro text
transfers to Adobe Premiere Pro’s title tool but loses the formatting. Also, crops in
the Final Cut Pro Motion Tab lose their feathering, because the crop filter in Premiere
Pro doesn't have soft edges.

It's also possible to import and export an Advanced Authoring Format (AAF) mul-
timedia file between Adobe Premiere Pro and Avid nonlinear editing systems that
support AAF files. Exchanging projects to and from Adobe Premiere Pro CS6 and
other non-Adobe systems offers the advantage of using the Adobe Suite of applica-
tions on projects that did not originate in Premiere Pro.

Exchanging project files between Adobe Premiere Pro and Final Cut Pro or Avid soft-
ware often requires additional but minor project organization and media manage-
ment due to the native incompatibility of these systems.

For more information on exchanging project files between Adobe Premiere Pro CS6

and Final Cut Pro or Avid software, go to http://tv.adobe.com/watch/short-and-suite/
premiere-pro-cs55-resources-for-professional-editors and http://www.video2brain.com/
en/premiere-pro-for-avid-editors.
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Review questions

1 How do you apply a Cross Dissolve transition?
How do you apply an effect to a clip?
What is an Adjustment Layer?

How do you create a static title clip in your Timeline?

wi A W N

What can you do if a clip in your Timeline shows unsteadiness due to a shaky handheld
camera?

Review answers
1 Click the Effects tab, select the Cross Dissolve effect from the Video Transitions folder,
and drag it to the Timeline between two clips or at the head or tail of a clip.

2 Select the clip in your Timeline, and then double-click on the effect in the Effects
panel. Or, drag the effect from the Effects panel onto the clip in the Timeline.

3 An Adjustment Layer is a clip that renders any effects applied to it onto any clip(s) in
the track(s) below it.

4 Choose Title > New Title > Default Still.
5 Apply the Warp Stabilizer effect to the clip.
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SYMBOLS

’ (apostrophe) key, toggling Title/Action Safe

guides, 175
— (minus) key, zooming out of Timeline, 91
\ (backslash) key
showing entire sequence, 92
zoom sequence to fit Timeline, 85
= (equal) key, zooming in on Timeline, 86
[ (left bracket key), adjusting In point,
187-191
] (right bracket key), adjusting Out point,
187-190

NUMBERS

2K video standard, 59

3D extrusions, creating in After Effects,
217-220

4:3 aspect ratio (fullscreen), video, 314

4K video standard, 59

16:9 aspect ratio (widescreen), video, 314

32-bit color, 301

A

A key (Direct Selection tool), 211
A key (layer anchor point), 196-197
AAF (Advanced Authoring Format)
multimedia file, 154
Action element, formatting screenplay, 37
Action safe area
adding titles with Premiere Pro, 147
creating custom DVD menu in
Encore, 338
Flash Professional interactivity, 349
text presets in After Effects, 175
Add Marker icon, 102—-103
Add Mode, applying in After Effects, 227,
246-247

Add Source button, AME, 317
Additional Assets folder
customizing DVD menu, 338
Flash Professional interactivity, 349
Additive Dissolve, 129
Add/Remove Keyframe icon, 266—267
Adjust Gain, Audio Gain command, 265
Adjustment Layer(s)
3D, After Effects, 218
3D extrusions in After Effects using, 218
adjusting anchor points with, 196-197
animating, 192-196
animating vertical scale, 198
applying Fast Blur to, 233-235
applying Motion blur to, 229-230
converting raster into vector with Image
Trace, 209-210
deactivating constrained proportions, 198
editing graphic after using Image Trace,
210-212
editing selected, 222
finishing touches, 201-202
importing Photoshop files into After
Effects, 179-181
keyframes and, 192
Liquify in Photoshop Extended using,
221-226
nested compositions using, 199
saving and exporting effect presets,
135-136
shape layers in After Effects using, 241
showing all effects on single layer, 232
swapping with different media item,
215-217
time-stretching, 200
Transfer Modes in After Effects using,
226-228
user interface, 16—17
working with, 132—134, 187-191



Adobe After Effects
3D extrusions, 217-220
about, 159
adding and animating effects, 231-235
archiving project, 322
Color Finesse, 300
compositions, adding to Queue in AME,
317-319
compositions, creating, 183—-186
compositions, integrating into Premiere
Pro Timeline, 248-250
compositions, Proxy rendering, 322
compositions, rendering, 319-322
creating project, 159-160
Dynamic Link between Premiere Pro and,
177-178
Dynamic Link integration between
Premiere Pro and, 166—170
Global Performance Cache, 161-163
importing vector image into, 212-215
Keylight, 141
most used effects, 231
Motion blur, 228-230
motion graphics, 178—183
optimizing performance, 160-161
organizing Project panel, 181-183
reloading changes in imported graphics,
215, 225-226
role of, 14
shape layers, 220, 240-244
static and animated masks, 236—240
swapping layers with different media item,
215-217
text and animation presets, 172—-177
Transfer Modes, 226—228
user interface, 163-165
Adobe Audition
about, 269
applying Transfer Mode to, 246247
Audio tools, 256
audio track editing, 284286
creating final audio mix, 286—287
finishing audio mix with multitrack
mixing, 278-282
real-time track mixing, 277
recording and editing voice-overs, 283
role of, 14
Adobe Audition, audio clip editing
cleaning up clip from Premiere Pro, 270
examining for distractions, 269

removing background noise, 273-276
removing transient sounds with Spectral
Frequency Display, 272—-273
Spectral Frequency Display and, 271
Adobe Bridge
about, 30
adding metadata in, 33-35
naming files in, 30
navigating and previewing media, 30-32
role of, 14
Adobe CS6 Production Premium, overview
general workflow, 12-13
linking project with media files, 19-23
real-time playback and editing, 24-25
review Q & A, 26
role of each application in, 14-15
types of media files, 17-19
user interface components, 15-17
using Dynamic Link, 17
Adobe Encore
about, 327
adding motion to DVD menus, 342—343
creating custom DVD menu, 334-340
DVD menu presets, 333—-334
DVD navigation using, 332-333
Dynamic Link between Premiere Pro and,
328-332
programming navigation in DVD menus,
340-342
role of, 14
testing project, 344
Adobe Flash Professional, 14, 349-350
Adobe Flash Professional CS6 Classroom in a
Book (Adobe Press, 2012), 349
Adobe ID, Adobe Story homepage, 38
Adobe Illustrator
about, 206
creating vector imagery with Image Trace,
207-210
editing Image-traced logo, 210-212
importing vector logo to After Effects,
212-215
role of, 14
swapping layer with different media item,
215-217
Adobe Media Encoder (AME)
about, 311-313
adding After Effects composition to
Queue in, 317-319
encoding for web and mobile, 316-317
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Adobe Media Encoder (AME) (continued)
features of, 312
role of, 14
saving presets with, 313-315
Adobe Photoshop
.psd files. See .psd files
importing files into After Effects, 179-181
Adobe Photoshop Extended
about, 221
features of, 221
importing curve color control presets in
After Effects from, 300
integration between After Effects and, 227
Liquify effect, 221-226
role of, 14
using Mercury Graphics Engine, 25, 223
Adobe Photoshop, importing files into After
Effects from, 179-181
Adobe Prelude
about, 43—44
adding notes to footage, 47
adding time-based comments, 50-52
assembling rough cut, 49-50
copying and transcoding footage to new
location, 47
creating bins, 48—49
exporting project to Premiere Pro, 52—53
ingesting footage, 44—47
role of, 14
Adobe Premiere Pro. See also editing,
advanced techniques; editing, basic
about, 58
applying Transfer Mode to, 246247
archiving project, 322
color correction, overview, 294
color correction, scopes, 296
color correction, set up, 294—295
color correction, Three-Way Color
Corrector, 297-300
color correction, YC Waveform, 295-296
creating new project in, 60—62
Dynamic Link integration between After
Effects and, 166-170, 177-178,
248-250
Dynamic Link integration between Encore
and, 328-332
exchanging files between Final Cut Pro/
Avid and, 154
exporting Prelude project, 5253
optimizing performance, 58—60
preparing final output sequence, 326—327

preserving rough edit, 158-159
role of, 14
sending sequence to SpeedGrade
from, 306
Title tool, 146-149
user interface, 63—-65
using clip from SpeedGrade in, 303-305
Adobe Premiere Pro, working with audio
Audio tools, 256
changing workspace, 256—-258
clip editing, 264—268
creating final edit sequence, 254—255
creating final mix, 286-288
effects, 262-263
examining audio clips for distractions, 269
exporting final audio mix, 287-288
opening Audio Mixer, 260-261
preserving final audio edit, 292-293
real-time track mixing, 277
recording and editing voice-overs, 283
removing background noise, 273-276
sending audio clips to Audition for
cleanup, 270
setting preferences, 259
viewing waveforms, 259-260
Adobe SpeedGrade
about, 301
color-correction presets, 301-303
role of, 14
sending sequence from Premiere Pro to,
306
using clip in Premiere Pro from, 304—306
Adobe Story
about, 35
basic film script page elements, 36—-37
starting new script, 38—41
Adobe Story Plus
about, 35
collaboration features, 41-43
reasons to upgrade to, 42
role of, 14
Advanced Authoring Format (AAF)
multimedia file, 154
After Effects. See Adobe After Effects
.ai files, vector images, 18—19, 207
.aiff files, audio clips, 18
Alignment, of titles, 148
Alpha channel, Ultra Key, 143-145
Alt+Tab (Command+Tab), switching between
open applications, 22, 165



AME. See Adobe Media Encoder (AME)
Amplitude
Audio Gain adjustments, 265
in Audio Mixer, 260
in final audio mix, 288
limiting audio track in Audition, 285
Reduce By setting for, 275
Spectral Frequency Display of, 271
Anchor points, adjusting on layers, 196—-197
Animation
After Effects presets for, 172-177
concept of, 160
creating masks in After Effects, 236-240
of effects, 231-235
with Flare Center, 168—170
keyframe-based, 192
of layers in After Effects, 192-196
of properties using wiggle expressions,
245-246
on vertical scale only, 198
Animation codec, AME, 313
Apostrophe (') key, toggling Title/ Action Safe
guides, 175
Applications
Adobe CS6 Production Premium Ul
for, 15-17
creating disk image for regular back up
of, 25
role of in CS6, 14-15
switching easily between open, 22
Apply Video Transition, 127
Archiving project, 322
Artboard, Illustrator, 213-214
Aspect ratio
rendering master files in AME, 313
understanding, 314
Assembly edits, rough cuts, 49-50
Assets
custom DVD menu, 339
importing as bins, 72-73
interactivity with Flash Professional, 349
navigating/previewing in Adobe Bridge,
30-32
shared management of, 32
Audio
applying L-cut to, 112
Audio tools, Premiere Pro and
Audition, 256
clip editing in Audition, 269-276
clip editing in Premiere Pro, 264—268

clip editing vs. track editing, 264
dynamic vs. condenser microphones, 282
final edit sequence in Premiere Pro,
254-255
final mix, 286-288
finishing mix in Audition with multitrack
mixing, 278-282
gaps, 96-98
monitoring, 255
overview of, 252-253
Premiere Pro effects, 262—-263
previewing in Source Monitor, 63
real-time track mixing, Premiere Pro and
Audition, 277
recording and editing voice-overs, 283
review Q & A, 289
track editing in Audition, 284286
using Audio Meters, 65
using Audio Mixer. See Audio Mixer,
Premiere Pro
using Speech to Text workflow, 82
verifying preferences, 259
viewing audio waveforms, 259-260
viewing footage, 76, 79
working with, 18, 93-96
workspace in Premiere Pro for, 256258
Audio Export settings, 313
Audio folder, importing assets as bins, 72-73
Audio Gain command, 265
Audio Meters panel, Premiere Pro, 65,
257-258
Audio Mixer, Premiere Pro
changing workspace to show, 256
opening, 260-261
raising or lowering volume of track, 95-96
real-time track mixing with, 277
Audio tools, Premiere Pro and Audition, 256
Audition. See Adobe Audition
Authoring
adding motion to DVD menus, 342—343
with Adobe Encore, 327
DVD navigation overview, 332—-340
Dynamic Link between Encore/Premiere
Pro, 328-332
ouputting DVD or Blu-ray Disc, 345-347
ouputting project as Flash for web,
348-349
overview of, 324-325
preparing final output sequence in
Premiere Pro, 326—-327
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Authoring (continued)
programming navigation in DVD menus,
340-342
review Q & A, 350
testing your project, 344—345
using Flash Professional, 349-350
.avi files, video clips, 17-18
Avid software, exchanging files between
Premiere Pro and, 154

B

Background
adding motion to DVD menus, 343
color for text and animation presets in
After Effects, 173
customizing DVD menus, 334-337, 339
green screen footage and, 137, 142-146
removing noise from audio clip in
Audition, 273-276
Backslash ( key
showing entire sequence, 92
zoom sequence to fit Timeline, 85
Backups, disk images for system, 25
Bins (folders)
creating for sequences, 83
creating in Prelude, 48—-49
creating new, 74-75
importing assets as, 72—-73
linking project with media files, 21
placing inside other bins, 48—49
understanding user interface, 17
Bitmap images, 18
Blend mode, After Effects, 226—228
Blu-ray Discs
mastering in Encore, 327
outputting, 345-347
using H.264 video compression, 19,
59, 308
Boris effect plug-ins, 136
Bridge. See Adobe Bridge
Brightness. See color correction
Broadcast standards, color correction for,
293-294
Build panel, Encore
outputting DVD or Blu-ray Disc, 345-347
outputting project as Flash for web,
348-349

C

Cache, Global Performance Cache, 24,
161-163
Capture tool, capturing from tape, 68
Character elements, screenplay formatting, 37
Character layers, animating, 195-196
Character panel, text layers, 174
Chroma Key effects
creating garbage matte, 138—-140
Keylight in After Effects, 141
overview of, 137
Ultra Key effect, 141-146
Chroma values, YC Waveform, 295-296
Clip editing
in Audition, 269-276
in Premiere Pro, 264—268
vs. track editing, 264
Clip markers
adding, 101-102
sequence markers vs., 103
snapping clips into sequence, 105-106
Closing shot, adding, 119-120
Codecs
Animation codec, 313
extensions and, 19
overview of, 313
Collaboration, with Adobe Story Plus, 41-43
Collect Files, After Effects, 322
Color
32-bit, 301
converting raster into vector image, 210
shape layers in After Effects, 240-244
Color correction
basics, 293-294
color temperature and, 297
Premiere Pro set up for, 294295
Premiere Pro tools for, 294
Premiere Pro’s Three-Way Color
Corrector, 297—-300
Premiere Pro’s YC Waveform, 295-297
sending sequence from Premiere Pro to
SpeedGrade, 306
SpeedGrade presets for, 301-303
SpeedGrade tools for, 301
using Color Finesse in After Effects, 300
using SpeedGrade clip in Premiere Pro,
304-306

Color Correction window, 32-bit color, 301



Color Dodge, After Effects, 227
Color Finesse, After Effects, 300
Color grading
Colorista II for, 136
overview of, 293—-294
SpeedGrade for. See Adobe SpeedGrade
Command (Ctrl), reordering clips on
Timeline, 91
Command+A (Ctrl+A), select all, 23
Command+C (Ctrl+C), copy, 124
Command+D (Ctrl+D), Apply Video
Transition, 127
Command+D (Ctrl+D), duplicate layers, 247
Command+down arrow (Ctrl+down arrow),
select the layer below currently selected
layer, 188
Command+E (Ctrl+E), editing selected
footage or layer, 222
Command+I (Ctrl+I), importing,
178-179, 248
Command+M (Ctrl+M), exporting media
from Premiere Pro, 309
Command+Option+0 (Ctrl+Alt+0), Render
Queue, 319
Command+S (Ctrl+S), saving project file, 23
Command+Shift+A (Ctrl+Shift+A),
deselecting clips, 71
Command+Shift+T (Ctrl+Shift+T), new text
layer in After Effects, 173
Command+T (Ctrl+T), free transform
bounding box for mask, 238
Command+Tab (Alt+Tab), switching between
open applications, 22, 165
Command+up arrow (Ctrl+up arrow), select
layer above currently selected layer, 188
Command+V (Ctrl+V), paste, 124
Command+W (Ctrl+W), closing bin, 23
Command+X (Ctrl+X), cut, 134
Comments
adding in Bridge, 33-35
adding time-based in Prelude, 50-51
adding to footage in Prelude, 47
viewing video clip in Project panel, 69-70
Compatibility, video format, 18
The Complete Guide to Standard Script
Formats (Hagg and Cole), 35
Components
Creative Suite, 14—15
Timeline, 85-86
user interface, 15-17

Compositing
concept of, 160
green screen footage, 137-140
static title clip with video clip, 149
Ultra Key correcting green screen, 141-146
Composition panel, After Effects, 164—165
Compositions, After Effects
adding still image to, 185-186
adding video clips to, 185
creating, 183-186
nested, 199
Project panel folder for, 183
Proxy rendering of, 322
rendering of, 319-322
text and animation presets, 172-173
using RAM Preview for, 170-171
Compression
audio clip formats and, 18
color temperature limitations, 297
exporting files using, 307—-308
exporting final output with Premiere Pro
using, 309-310
H.264 video, 59
rendering master files in AME using,
312-313
Condenser microphones, 282
Constrained proportions, deactivating, 198
Convert Sample Type window, exporting final
audio mix, 286
Cool colors, using Three-Way Color
Corrector, 297-300
Copying and pasting
animated masks in After Effects, 239—-240
animating character layers, 195-196
effects, 132
final audio edit in Premiere Pro, 292-293
final edit sequence, 254
rough edit in Premiere Pro, 158
text in After Effects, 173
transitions, 127-128
versioning your edit using, 124
Copying footage to new location, 47
CPU core, Multiprocessor Rendering in After
Effects, 320-321
Crop effect, garbage mattes, 139
Cross Dissolve
applying, 127-129
defined, 129
Dynamic Link between Encore/Premiere
Pro, 332
CTI. See current time indicator (CTI)
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Ctr]l (Command), reordering clips on
Timeline, 91
Ctrl+A (Command+A), select all, 23
Ctrl+Alt+0 (Command+Option+0), Render
Queue, 319
Ctrl+C (Command+C), copy, 124
Ctrl+D (Command+D), Apply Video
Transition, 127
Ctrl+D (Command+D), duplicate layers, 247
Ctrl+down arrow (Command+down arrow),
select the layer below currently selected
layer, 188
Ctrl+E (Command+E), editing selected
footage or layer, 222
Ctrl+I (Command+I), importing, 178-179, 248
Ctrl+M (Command+M), exporting media
from Premiere Pro, 309
Ctrl+S (Command+S), saving project file, 23
Ctrl+Shift+A (Command+Shift+A),
deselecting clips, 71
Ctrl+Shift+T (Command-+Shift+T), new text
layer in After Effects, 173
Ctrl+T (Command+T), free transform
bounding box for mask, 238
Ctrl+up arrow (Command-+up arrow), select
layer above currently selected layer, 188
Ctrl+V (Command+V), paste, 124
Ctrl+W (Command+W), closing bin, 23
Ctrl+X (Command+X), cut, 134
CUDA technology, Mercury Playback
Engine, 24
Current time indicator (CTI)
adjusting backward or forward five
frames, 267
adjusting backward or forward ten
frames, 188-191
adjusting timeline footage, 16
linking project with media files, 21, 23
Three-Way Color Corrector using, 299
Curve controls, Color Finesse, 300
Custom DVD menu, 334-340

D

Damage effect plug-ins, 136
Data compression
image quality vs., 347
lossless compression using, 307
DAWs (digital audio workstations), 277
Deactivating constrained proportions,
layers, 198

Delay effect, audio in Premiere Pro, 262
Delete key
removing clips, 92
removing Live clips, 118—-119
using gaps in audio to refine story, 97-98
Delirium effect plug-ins, 136
Destinations, transferring footage to new,
45, 47
Dialogue elements, screenplay formatting, 37
Digieffects plug-ins, 136
Digital audio workstations (DAWs), 277
Direct Selection tool (A key), 211
Disk image, for system back up, 25
Dissolve, transitioning between clips,
125-126
Double-click, applying effect to clip, 139
Downloading video, vs. streaming, 319
.dpx image files, SpeedGrade, 301, 306
Drag Video Only icon, creating garbage
matte, 138
Drop Shadow effect, After Effects, 231
Duplicating layers, 247
Duration
composition settings in After Effects, 172
modifying transitions, 128—129
sorting clips, 69
time-stretching video clips, 200
DVD navigation
adding motion to DVD menu, 342-343
customizing DVD menu, 334340
overview, 332-333
programming in DVD menu, 340-342
region codes for, 330
testing project, 344345
using DVD menu presets, 333—-334
DVDs
authoring in Encore, 327
burning project to blank, 346
creating simple auto-play, 331
HD movies mastered to standard, 328
outputting, 345-347
Dynamic Link
integrating Premiere Pro/After Effects
work, 166-170, 177-178, 248-250
integrating Premiere Pro/Encore work,
328-332
overview of, 17
Dynamic microphones, 282
Dynamic Timeline Trimming, 99-101
Dynamics effects, audio in Premiere Pro, 262



E

E key (showing all effects on single layer), 232
Easy Ease
animating layers, 193—-194
animating vertical scale only, 198
applying finishing touches, 202
creating static/animated masks in After
Effects, 239
Edit Clip In Adobe Audition, Premiere
Pro, 270
Edit points, 104, 118
Editable Layer Styles, 180
Edited sequence, image sequence vs., 304
Editing
adding time-based comments, 50-52
audio clips in Audition, 269-276
audio clips in Premiere Pro, 264—268
audio clips vs. audio track, 264
bitmap image files using Photoshop, 18
final audio. See final audio edit
final output sequence in Premiere Pro,
326-327
final sequence in Premiere Pro, 254—255
Image Traced graphic, 210-212
rough cuts, 49-50
selected footage or layer, 222
voice-overs, 283
Editing, advanced techniques
adding titles with Title tool, 146—-149
adding transitions, 125-129
applying effects to clips, 130-131
applying Ultra Key, 141-146
changing render order of effects, 131-132
copying and pasting effects, 132
effects in Premiere Pro, 129-130
keying and compositing green screen
footage, 137-140
open workflows with other
applications, 154
overview of, 122—-123
preview render of Timeline, 152-153
review Q & A, 155
saving and exporting presets, 135-136
stabilizing footage with Warp Stabilizer,
150-152
third-party effect plug-ins, 136
using Adjustment Layers, 132—-134
using Keylight in Adobe After Effects, 141
versioning, 124—-125

Editing, basic
about Adobe Premier Pro, 58—59
creating bins, 72-75
creating first sequence, 83—84
creating new project, 60—65
creating subclips, 79-82
finishing rough edit, 108-114
importing footage with Media Browser,
66—68
interpreting footage, 71-72
linear vs. nonlinear, 58
of live clips, 114—120
Multicam, 101
overview of, 5657
real-time playback and, 24-25
review Q & A, 121
trimming edits, 98—99
understanding Project panel, 68-70
understanding RAID, 60
using Dynamic Timeline Trimming,
99-101
using gaps in audio, 96-98
using markers, 101-103
using Snap feature, 104—108
viewing footage, 75-78
working in Timeline. See Timeline, Adobe
Premiere Pro
working with audio, 93-96
Editing workspace, Adobe Premiere Pro,
63-65
Effect Controls panel (Shift+5), Premiere Pro,
266-268
Effects. See also Adobe After Effects
applying to clips, 130-131
changing render order of, 131-132
copying and pasting, 132
motion graphics and visual. See motion
graphics and visual effects
overview of, 129-130
Premiere Pro audio, 262263
saving and exporting presets, 135-136
of shape layers in After Effects, 220
showing all on single layer, 232
third-party effect plug-ins for, 136
using Adjustment Layers, 132—-134
Effects & Presets panel, After Effects, 165,
176-177
Effects panel (Shift+7), 135-136
Ellipse Path, shape layers, 241-242
E-mail, Adobe Story Plus, 43
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Enable Disk Cache, Global Performance
Cache, 162
Encoding
with AME. See Adobe Media Encoder
(AME)
DVD or Blu-ray content, 347
exporting final output with Premiere
Pro, 310
Encore. See Adobe Encore
Enter key, editing text layer, 174
.eps files, vector images, 18, 207
Equal (=) key, zoom Timeline, 86
Exporting
compression and, 307-308
file size and, 308
final audio mix from Audition, 286—287
final output with Premiere Pro, 308-310
format and, 308
frame rates and, 308
overview of, 306
to Premiere Pro, 52—-53
presets, 135-136
rendering master files in AME, 312-313
saving preset, 314—315
Exports folder, Adobe Bridge, 31
Expressions
understanding, 244
wiggle, 245-246
Extensions, codecs and, 19
Extrusions, 3D, 217-220

F

F4 key (Toggle Switches/Modes), 226
Fade In and Fade Out, final audio mix, 282
Fade Up Characters preset, 176—-177
Fader, Audio Mixer, 261
Fast Blur effect, After Effects, 231-235,
243-334
Favorites folder, Adobe Bridge, 30
File size, exporting files and, 308
Final audio edit
adding fade, 282
adding sound effect, 279-281
creating final edit sequence, 254—255
creating final mix, 286-288
preserving in Premiere Pro, 292-293
Final Cut Pro, exchanging files with Premiere
Pro, 154
Final output sequence, 326-327

Finishing, rendering, and outputting
32-bit color, 301
about Adobe Media Encoder, 311-313
about SpeedGrade, 301
adding After Effects composition to
Queue in AME, 317-319
archiving project, 322
color correction basics, 293—294
color correction in Premiere Pro, 294—300
Color Finesse in After Effects, 300
color-correction presets in SpeedGrade,
301-303
encoding for web and mobile with AME,
316-317
exporting files, 307—-308
exporting final output with Premiere Pro,
308-310
overview of, 290-291
preserving final audio edit in Premiere
Pro, 292-293
proxy rendering in After Effects, 322
rendering compositions in After Effects,
319-322
review Q & A, 323
saving presets with AME, 313-315
sending sequence from Premiere Pro to
SpeedGrade, 306
streaming vs. downloading, 319
using clip from SpeedGrade in Premiere
Pro, 304-306
Flare Center, Lens Flare effect, 168—170
Flash
ouputting project for web, 348—349
for web content, 347
Flash frames, removing, 113
Flash Professional, 14, 349-350
Flowchart panel, Encore, 330, 342
Fonts
copying and pasting text between Adobe
applications, 173
serif vs. sans serif, 149
title, 146-149
Footage
editing selected, 222
importing using Media Browser, 66—68
interpreting, 71-72
organizing after transferring to computer.
See Adobe Prelude
organizing in After Effects Project panel,
181-183



reloading changes in imported
graphics, 215
stabilizing with Warp Stabilizer, 150-152
swapping layer with different media item,
215-217
viewing, 75-78
Footage folder
adding motion to DVD menus, 343
adding video clips in After Effects, 185
Adobe Bridge, 31
within After Effects Project panel,
181-182
importing footage using Media Browser,
66-68
importing media files for motion
graphics, 178
ingesting footage in Prelude, 44—46
Foreground, green screen footage and, 137
Formats
compatibility of video, 18
copying and pasting text between Adobe
applications and, 173
exporting files, 308
lossy compression, 307
media file, 17-18
raster image, 207
screenplay, 35—-36
vector image, 207
Fps (frames per second), 71-72
Frame rate
2K/4K and high, 59
creating composition in After Effects and,
172, 184
exporting files and, 308
importing image sequence to Premiere
Pro and, 303-304
rendering master files in AME and, 313
Frames per second (fps), 71-72
Free transform bounding box, masks, 238-239
Frequency
audio track editing in Audition, 284
audio waveform displaying audio clip,
259-260
examining clips for distractions, 268
Parametric Equalizer effect adjusting, 262
removing background noise, 272-276
using Spectral Frequency Display,
271-273
Full HD (standard HDTV aspect ratio), 314
Fullscreen video (4:3 aspect ratio), 314

G

Gain, audio, 265
Gaps
editing Live clips, 115
refining story in audio with, 96-98
removing flash frames, 113
removing from sequence with Ripple
Delete, 92—-93
Garbage matte, green screen footage,
138-140
General elements, screenplay formatting, 37
Global Performance Cache, 24, 161-163
GPU acceleration
checking whether you are using, 24
format compatibility, 18
graphics cards supporting, 59, 161
SpeedGrade with, 301
Three-Way Color Corrector with, 298
Graphics
adding to composition, 185-186
advanced motion. See motion graphics
and stills, advanced techniques
converting into, 208-210
motion. See motion graphics and visual
effects
Graphics cards
optimizing After Effects performance, 161
Premiere Pro, 59
supporting GPU acceleration, 59, 161
Graphics folder, Adobe Bridge, 31
Graphics folder, After Effects
adding video clips to composition, 185
importing layered Photoshop files,
179-181
importing media files for motion
graphics, 178
importing vector image, 212
organizing Project panel with, 182—183
Gray bar, on Timeline, 152
Green screen footage
applying Ultra Key to create composite,
141-146
keying and compositing, 137-140
using Keylight in After Effects, 141
viewing, 78
Grouping multiple layers, nested
compositions, 199
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H

H.264 files
.mp4 video format integral to, 310
defined, 59
exporting final output with Premiere Pro,
309-310
replacing Flash Player on web, 347
as standard video compression, 308
use of in this book, 58
Hard drives, and After Effects
performance, 161
Hardware, optimizing
After Effects performance, 160-161
Premiere Pro performance, 58—60
HDR (high dynamic range) footage, 301
Headphones
monitoring audio, 255
verifying audio preferences, 259
High dynamic range (HDR) footage, 301
High frame rates, 59
Highlights dropper, Three-Way Color
Corrector, 299
Histogram
Color Finesse in After Effects, 300
Levels effect in After Effects with, 231
Homepage, Adobe Story, 38
Hover-scrub, 67, 77
Hue. See color correction
Hue/Saturation effect, After Effects, 231

Icon View
displaying clips in bin using, 108
Project panel displaying items in, 68
viewing Live footage in, 77
Illustrator. See Adobe Illustrator
Image sequence
edited sequence vs., 304
importing and interpreting, 304—305
rendering new .tga, 303
Image Trace
creating vector imagery with, 207
editing graphic after using, 210-212
importing vector image into After Effects,
212-215
Importing
After Effects composition into Premiere
Pro, 248-250
assets as bins, 72-73

final audio mix into Premiere Pro,
287-288
footage and other media using Media
Browser, 66—68
image sequence to Premiere Pro,
303-305
layered Photoshop files into After
Effects, 179-181
media files for motion graphics,
178-179
vector images into After Effects,
212-215
In points
adding time-based comments in Prelude,
51-52
adjusting to current time for layer,
187-190
animating layers, 192
editing sequence in Source Monitor, 63
ingesting footage in Adobe Prelude, 45
removing background noise, 274
snapping clips into sequence, 105-106
Info panel, After Effects, 165
Ingest panel, Adobe Prelude, 44—46
Input Levels slider, Three-Way Color
Corrector, 299
Insert edit, 90-91
Interactivity, Flash Professional, 349

J

jpg files, 18, 207

K

Keyframes
animating character layers, 195-196
animating layers, 192—-196
animating text in After Effects, 176—-177
animating text layers, 194
animating vertical scale only, 198
applying Easy Ease to, 193
editing audio clips in Premiere Pro,
266—-268
real-time track-mixing in Premiere Pro
and Audition, 277
understanding, 192
Keying, green screen footage, 137-140
Knoll Light Factory, Lens Flare
effect, 168



L

Lasso tool, using Spectral Frequency
Display, 272
Layers
in Adobe Illustrator. See Adobe Illustrator
Adobe Photoshop Extended, 221-226
Layers, Creative S6 Production Premium UI,
16-17
Layers, in After Effects
adding/animating effects using, 231-235
adjusting anchor points, 196197
animating vertical scale only, 198
animating your, 192-196
applying Motion blur, 228-230
creating 3D extrusions, 217-220
creating static/animated masks, 236—-240
deactivating constrained proportions, 198
duplicating, 247
finishing touches to, 201-202
importing Photoshop files into, 179-181
most used, 231
shape layers in, 220, 240244
time-stretching, 200
understanding expressions, 244—246
understanding keyframes, 192
using nested compositions, 199
using Transfer Modes, 226—228
working with, 187-191
Layers panel, Adobe Encore
creating custom DVD menu, 334-338
programming navigation in DVD menus,
340-342
using DVD menu presets, 334
L-cuts, 112
Lens Flare effect
creating, 167-170
third-party plug-ins for, 168
using RAM Preview for, 170-171
Levels effect, After Effects, 231
Library panel, Adobe Encore, 333-334
Lighten Mode, After Effects, 227
Limiting, audio output, 286
Linear editing systems, 58
Link-based project files
linking project with media files, 20-23
understanding, 19
Liquify effect, Adobe Photoshop Extended,
221-226
List view, Media Browser, 66, 68—70

Listening, to footage, 76
Live clips
bridging to Studio clips, 110-111
editing, 114—120
enhancing with music and sound
effects, 79
showing and relinking in Live bin, 22-23
viewing Live footage, 77-78
Lock Aspect Ratio, Composition Settings
dialog, 184
Log Note column, Project panel, 69-70
Logging clips
adding notes when, 35, 47
viewing notes in Project panel, 69-70
Look tab, SpeedGrade, 302
Lossless compression, 307
Lossy compression, 307
Loudness Maximizer, Audition, 284
Luminance
Additive Dissolve transition and, 129
Trapcode Shine plug-in enhancing, 136
video frame categories for, 302
video frames and, 302
YC Waveform ensuring broadcast-safe
range of, 295-296, 299
YCbCr Parade scopes displaying, 296

M

M key (adding marker at current frame),
102-103
Magic Bullet Suite effect plug-ins, 136
Magnification menu, After Effects, 215
Marker Type panel, time-based comments in
Prelude, 50-52

Markers

adding to clip, 101-102

adding to sequence, 102—-103

clip vs. sequence, 103

editing Live clips, 115-116

snapping between edit points, 104
Marquee-select

defined, 74

with Dynamic Timeline Trimming,

100-101

finding edit point for Live clips, 118

rearranging clips in video tracks, 117
Masks

color grading with, 292-293

creating static and animated, 236—240
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Master files
adding After Effects composition to
Queue in AME and rendering,
317-319
batch compressing in AME, 312
rendering in AME, 312-313
rendering using lossless compression, 307
Matte Cleanup, Ultra Key effect, 145
Matte Generation, Ultra Key effect, 144
Maximum Disk Cache size, Global
Performance Cache, 162
Media & Disk Cache, Global Performance
Cache, 162
Media Browser
importing assets as bins, 72-73
importing footage and other media,
66—68
Media Duration heading, sorting Project
panel, 69
Media files
about Adobe Bridge, 30-32
about Adobe Prelude. See Adobe Prelude
about Adobe Story. See Adobe Story
exporting project to Premiere Pro, 52—53
importing for motion graphic, 178-179
linking project with, 19-23
organizing into folders and bins, 17
overview of, 28—29
review Q & A, 54
shared asset management storage and
integration, 32
video production, 17-19
working with metadata, 33-35
Menu Viewer, Adobe Encore, 335-339
Mercury Graphics Engine, 25
Mercury Performance System, 25
Mercury Playback Engine, 24
Metadata
adding to footage in Prelude, 47
adding to media files, 34—35
viewing video clip in Project panel, 69-70
working with, 33
Microphones
dynamic and condenser, 282
recording and editing voice-overs, 283
Midtones dropper, Three-Way Color
Corrector, 299
Minus (-) key, zooming out of Timeline, 91

Mixer, real-time track-mixing in Audition, 277

MM keys (mask properties), 238

Mobile devices
encoding video for, 316-317
Flash content not supported on, 347
Modify Clip window, Premiere Pro, 71-72
Monitor tab, SpeedGrade, 302
Monitoring
audio, 255
audio preferences, 259
color with Premiere Pro scopes, 296
Motion, adding to DVD menus, 342-343
Motion blur, 228-230, 246
Motion graphics and stills, advanced
techniques
3D extrusions, 217-220
3D in After Effects, 218
adding and animating effects, 231-235
duplicating layers, 247
incrementing After Effects project, 206
integrating After Effect composition into
Premiere Pro, 248—-250
most used After Effects effects, 231
Motion blur, 228-230, 246
overview of, 204-205
Ray-traced 3D Renderer, 219
review Q & A, 251
shape layers, 220, 240-244
static and animated masks, 244
Transfer Model, 246—247
Transfer Modes, 226—228
understanding expressions, 244
using Adobe Illustrator. See Adobe
Ilustrator
using Adobe Photoshop Extended,
221-226
wiggle expression, 245-246
Motion graphics and visual effects
about Adobe After Effects, 159-163
After Effects user interface, 163—-165
creating new composition, 183-186
creating with After Effects, 178—183
Dynamic Link integrating Premiere Pro/
After Effects work, 166—170
overview of, 156-157
preserving rough edit in Premiere Pro,
158-159
review Q & A, 203
text and animation presets in After
Effects, 172-177
using RAM Preview, 170-171
working with layers. See layers



.mov files
video clips as, 17
video format compatibility, 18
Move tool, 281
.mp3 files, audio clips, 18
.mp4 video format
defined, 310
replacing Flash Player on web, 347
video clips as, 17
Multiprocessor Rendering, After Effects,
320-321
Music effects, 79

N

Name heading, sorting Project panel, 69
Naming conventions
bins, 74-75
final audio edit in Premiere Pro, 292
final output sequence in Premiere Pro, 326
presets, 314
project and media files, 30
rough edit in Premiere Pro, 158
sequences, 83
versioning your edit, 124125
Navigation
adding After Effects composition to
Queue in AME, 317-319
for color-correction presets in
SpeedGrade, 301-303
creating for DVDs. See Adobe Encore
fixing offline media links, 22
for media in Adobe Bridge, 30-32
Nested compositions, 199
New Project
Adobe Prelude, 44
Adobe Story, 39
Premiere Pro, 60-62
New Sequence dialog, Premier Pro, 62
Noise
examining audio clips for distractions, 269
removing from background, 273-276
removing transient sounds using Spectral
Frequency Display, 272-273
sending clip to Audition for cleanup, 270
viewing in Spectral Frequency Display, 271
Noise Reduction effect, 274-276
Nonlinear editing systems, 58
Normalize All Peaks, Audio Gain
command, 265

Normalize Max Peak, Audio Gain
command, 265

Notes. See comments

NTSC system, 329-330

(o)

Offline media, fixing links for, 22-23
Online references
After Effects graphics cards, 161
CUDA and OpenCL technologies, 24
DVD menu presets, 334
exchanging project files between Final Cut
Pro/Avid, 154
GPUs supporting Ray-traced 3D
Renderer, 217
Mercury Playback Engine, 24
optimizing After Effects for Global
Performance Cache, 163
Premiere Pro graphics cards, 59
QuickTime Player download, 312
Ray-traced 3D Renderer, 219
shared asset management, 32
third-party effect plug-ins, 136
Opacity. See T key (Opacity)
Open After Effects Composition window, 318
Open GL, After Effects performance, 160
Open Project button, 20
OpenCL technologies, for Mercury Playback
Engine, 24
Operating system back up, disk image for, 25
Optical Flares plug-ins, Lens Flare, 168
Out points
adjusting to current time for layer, 187-190
editing sequence in Source Monitor, 63
ingesting footage in Adobe Prelude, 4546
removing background noise, 274
snapping clips into sequence, 105-106
time-based comments in Prelude, 51-52
Output
of DVD or Blu-ray Disc, 345-347
preparing final sequence in Premiere Pro,
326-327
of project as Flash for web, 348-349
using Premiere Pro to export final,
308-310
Output tab, SpeedGrade, 303
Overwrite edit, 90
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P

P key (Position)
adjusting anchor points, 196—-197
animating layers, 192, 194
animating text layers, 194
shrinking video layers and placing in
frame, 201
using wiggle expression on shape layer,
245-246
PAL (Phase Alternating Line) system,
328-329
Paragraph panel, creating text layer, 174
Parametric Equalization effect, audio, 262,
284-285
Parenthetical elements, screenplay
formatting, 37
Password, Adobe Story homepage, 38
Peak Amplitude, Audio Gain command, 265
Pedestal property, Ultra Key effect, 144
Performance
optimizing Adobe After Effects, 160-161
optimizing Premiere Pro, 58—60
Ray-traced 3D Renderer in After
Effects, 220

Phantom HD cameras, high frame rates of, 59

Phase Alternating Line (PAL) system,
328-329
Photoshop
.psd files. See .psd files

importing files into After Effects, 179-181

Photoshop Extended. See Adobe Photoshop
Extended
Pick-whip tools, Encore, 331, 341
Pixel Aspect Ratio, Composition Settings
dialog, 184
Pixels, 2K/4K and high frame rates, 59
Placeholder text
creating custom DVD menu, 334-336
creating project in Adobe Story, 40-41
“Planning to playback” video production
workflow, 12-13
Play Around (Shift+K), 127-128
Playback
real-time, 24—25
toggling in Timeline with spacebar, 23
.png files, 18, 207
Position. See P key (Position)
Postproduction phase, 30—32
Postproduction phase workflow, 13
Postroll values, previewing transitions, 127

Preferences
audio in Premiere Pro, 259
optimizing After Effects for Global
Performance Cache, 162-163
Prelude. See Adobe Prelude
Premiere Pro. See Adobe Premiere Pro
Preproduction phase workflow, 12
Preroll values, previewing transitions, 127
Preset Browser, Adobe Media Encoder,
315-317
Presets
audio track editing in Audition, 284-286
color correction in Premiere Pro, 294—295
color correction in SpeedGrade, 301-302
creating project in Premier Pro, 62
defined, 15
Encore DVD menu, 333-334
exporting final output with Premiere Pro,
308-310
rendering compositions in After
Effects, 320
saving, 314
saving and exporting, 135-136
text and animation in After Effects,
172-177
Preview panel, After Effects, 165
Preview renders
generating on Timeline, 152-153
in Global Performance Cache, 161
Previewing media
in Bridge, 32
using Media Browser, 66—68
Production phase workflow, 13
Program Monitor, Adobe Premiere Pro
adding marker to sequence, 102—103
applying Warp Stabilizer, 151
correcting green screen with Chroma Key,
142-143
creating garbage matte, 139-140
defined, 64
editing on Timeline, 87-88
trimming edits, 98-99
Programming navigation in DVD menus,
340-342
Project Manager, archiving project, 322
Project panel, Adobe Premiere Pro
adding marker to sequence, 103
creating new bin, 74-75
creating new bin for sequences, 83
creating subclip, 80
defined, 64



imported After Effects composition
appearing in, 249-250
interpreting footage, 71-72
making final edit sequence, 254—255
understanding, 68-70
using Adjustment Layers, 132-134
Project panel, After Effects
adding video clips to composition, 185
defined, 164
importing vector image into, 213
swapping layer with different media item,
216-217
Project panel, Encore
adding motion to DVD menus, 343
creating custom DVD menu, 337
using Dynamic Link to send edit to
Encore, 329-330
Project Preview, DVD navigation project, 344
Properties
adding motion to DVD menus, 343
animating using wiggle expressions,
245-246
creating keyframes for, 191
Encore Properties panel, 331
programming navigation in DVD menus,
340-342
Proxy rendering, After Effects, 322
.psd files
editing bitmap image files using, 18
importing layered Photoshop files into
After Effects, 179-181
saving raster image as, 207
as self-contained, 19
using Liquify in Photoshop Extended, 225

Q

Queue, Adobe Media Encoder, 315, 317-319
QuickTime movie format, 312-313, 318

R

Rack Effect window, Audition, 284—286
RAID (Redundant Array of Independent
Disks), 59—-60
RAM, optimizing performance, 59, 160
RAM Preview
adjusting anchor points, 197
animated mask in After Effects, 240
animated text in After Effects, 176—177
duplicating layers, 247

Global Performance Cache benefits,
161-162
overview of, 170-171
reducing resolution for, 171
shrinking video layers and placing in
frame, 202
viewing Motion blur, 229-230
wiggle expression, 246
Ramp effect, After Effects, 231
Raster images, 207-210
Ray-traced 3D Renderer, After Effects,
217-220
Recording
music with condenser microphones, 282
voice-over, 283
Rectangle tool, masks in After Effects, 237
Red bar(s), on Timeline, 152—153
RED cameras, high frame rates of, 59
Red Giant Software effect plug-ins, 136, 168
Reduce By value, Noise Reduction slider, 275
Redundant Array of Independent Disks
(RAID), 60
Reference panel, color correction in Premiere
Pro, 295
Region codes, DVD, 330, 345
Reload Footage, After Effects, 215, 226
Removing clips, on Timeline, 92-93
Render Queue, After Effects, 319-322
Rendering
After Effects composition in AME,
317-319
changing order of effects, 131-132
clip from SpeedGrade, 302-303
compositions in After Effects, 160,
319-322
encoding video for web and mobile,
316-317
final output with Premiere Pro, 310
master copy with lossless compression, 307
master files, 312-313
proxy rendering in After Effects, 322
testing DVD navigation project, 344—345
Timeline, 152-153
video compression during, 307
Reordering clips, on Timeline, 90-92
Reset Current Workspace, Premiere Pro, 256
Resolution
green screen footage results and, 137
reducing for RAM Previews, 171
vector images independent of, 18
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Return key, editing text layer in After
Effects, 174
Reverb effect, Premiere Pro, 262
RGB Parade, Premiere Pro, 296
Ripple Delete, 92-93
Ripple Delete (Shift+Delete), 93
Ripple Edit tool, 98-99
Rolling Edit tool, 100-101
Rolling Shutter Repair effect, 152
Rough cuts, assembling in Prelude, 49-50
Rough edit, finishing
adding more clips, 108—109
adding sound bite to sequence, 110
applying L-cut, 112
bridging Live clips to Studio clips,
110-111
final trimming, 113-114
preserving in Premiere Pro, 158—159
removing flash frames, 113
trimming clips with sound bite, 109

S

S key (Scale)
animating layers, 192—193
animating vertical scale only, 198
deactivating constrained proportions, 198
shrinking video layers and placing in
frame, 201-202
Sample rate, exporting final audio mix, 286
Sans serif fonts, 149
Saturation. See color correction
Saving
effect presets, 135-136
versioning your edit, 124125
Scale. See S key (Scale)
Scene heading elements, screenplay
formatting, 37
Scopes, monitoring color information, 296
Screen Mode, 227-228
Scripts, film. See Adobe Story; Adobe Story
Plus
Scrubbing
CTI in Timeline to view title, 147
defined, 21
ingesting footage in Prelude, 44—46
linking project with media files, 23
using hover-scrub, 67
Segments, extracting subclips from, 79
Sequence markers, 102-103, 106—107

Sequences
adding sound bite to, 110
creating in Adobe Premier Pro, 62, 83-84
defined, 62, 83
final audio edit in Premiere Pro, 292-293
final output in Premiere Pro, 326-327
importing image, to Premiere Pro,
303-305
making final edit, 254—255
rendering as .tga file in SpeedGrade, 303
rough edit in Premiere Pro, 158—159
sending from Premiere Pro to
SpeedGrade, 306
snapping clips within, 105-107
working in Timeline with. See Timeline,
Adobe Premiere Pro
zooming to fit Timeline, 85
Serif fonts, vs. san serif, 149
Set Gain, Audio Gain command, 265
Shadow, Ultra Key effect, 144
Shadows dropper, Three-Way Color
Corrector, 299
Shape layers
adding Motion blur to, 246
in After Effects, 220
creating 3D extrusions in After Effects,
217-220
duplicating, 247
using wiggle expression on, 245-246
working with, 240-244
Shared asset management, 32
Shift+5 (Effect Controls panel), Premiere Pro,
266-268
Shift+7 (Effects panel), 135-136
Shift+Delete (Ripple Delete), 93
Shift+K (Play Around), 127-128
Shift+left arrow (adjust CTI backward five
frames), 267-268
Shift+Page Down (adjust CTI forward ten
frames), 188
Shift+Page Up (adjust CTI back ten
frames), 188
Shift+right arrow (adjust CTI forward five
frames), 267-268
Shot elements, screenplay formatting, 37
Show Safe Area, Menu Viewer, 338—339
Shutter Angle property, Motion blur, 230
Sign In window, Adobe Story homepage, 38
Smartphones, encoded video for, 316-317
Snap feature, 104—106



Solid state drives (SSDs), 161
Solo switches, After Effects, 227
Sorting, Project panel in List view, 68—70
Sound bites
adding to sequence, 110
trimming clip with, 109
Sound effects
adding to final audio mix, 279-281
listening to footage, 79
Source Monitor, Adobe Premiere Pro
adding marker to clip, 102
creating garbage matte, 138—139
creating subclip, 80-82
defined, 63
integrating After Effects composition, 249
interpreting footage n, 72
listening to footage, 76
listening to music and sound effects, 79
snapping clips into sequence, 105-106
trimming clip with sound bite, 109
viewing green screen footage, 78
viewing Live footage, 77
Spacebar, toggling playback in Timeline, 23
Speakers
monitoring audio, 255
verifying audio preferences, 259
Spectral Frequency Display
removing transient sounds, 272—273
understanding, 271
Speech to Text workflow, 82
SpeedGrade. See Adobe SpeedGrade
SSDs (solid state drives), 161
Stabilizing footage, Warp Stabilizer, 150—152
Standard workspace, After Effects, 163—-165
Static title clip, compositing with video
clip, 149
Still images
adding to composition, 185-186
advanced techniques for. See motion
graphics and stills, advanced
techniques
creating custom DVD menu, 339
Stopwatch icons
animating character layers, 195
animating layers, 193
animating text layers, 194
creating keyframes for properties, 191
shrinking video layers and placing in
frame, 202
Storage, shared asset management, 32

Story. See Adobe Story; Adobe Story Plus
Streaming video, 319
Studio clips, 110-111
Subclips, 79-82
Swapping layer, with different media item,
215-217
.swf files
authoring in Encore, 327
creating interactivity with Flash
Professional, 349-350
Flash content on web, 347
outputting project as Flash for web,
348-349
Synthetic Aperture Color Finesse plug-in,
After Effects, 300

T

T key (Opacity)
animating character layers, 195-196
animating layers, 192—-193
animating text layers, 194
applying Transfer Mode, 246—247
Tape, capturing from, 68
Television Standard, 328—329
Temperature, color, 297
Testing DVD navigation project, 344—345
Text
animating layers, 194
creating custom DVD menu, 335-336
editing layers in After Effects, 173-175
integrating work between Premiere Pro/
After Effects, 177-178
placeholder, 40-41, 334-336
presets in After Effects, 172-177
.tga files, 18, 303—-306
Third-party effect plug-ins
Lens Flare effect, 168
overview of, 136
Three-Way Color Corrector, 154,
297-300, 314
Thumbnail view, Media Browser, 66—67
Thumbnails, ingesting footage in Adobe
Prelude, 44-46
.tif files, bitmaps, 18
tiff files, raster images, 207
Timecode, After Effects compositions, 184
Timeline
adding time-based comments on clips in
Prelude, 50-52
assembling rough cut, 49-50
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Timeline (continued)
linking project with media files, 21
rendering, 152-153
toggling playback with spacebar, 23
understanding user interface, 16
zooming in and out of, 91
Timeline, Adobe Premiere Pro
adding marker to sequence, 102—103
adjusting audio volume, 255
components, 85-86
defined, 65
Dynamic Link integrating After Effects
work into, 166, 177-178, 248-250
Dynamic Timeline Trimming, 100-101
editing on, 86—88
final edit sequence, 254255
gaps in audio to refine story, 97-98
preparing to edit, 84—85
removing clips, 92-93
reordering clips, 90-92
replacing clip with different source,
305-306
Snap, 104-108
text and animation presets in After
Effects, 173
trimming edits, 98—99
working with tracks, 89
Timeline, After Effects
animated properties and keyframes, 176
creating Lens Flare effect, 168—170
defined, 165
navigating in, 169
swapping layer with different media item,
216-217
Timeline, SpeedGrade, 302
Time-stretching, 200
Title
creating with Premiere Pro Title tool,
146-149
text and animation presets in After
Effects, 172-177
Title Monitor, Premiere Pro, 147
Title safe area
adding titles with Title tool, 147-148
creating custom DVD menu, 338
Flash Professional, 349
text presets in After Effects, 175
toggling with apostrophe (’) key, 175
Title tool, Premiere Pro, 146—149
Toggle Switches/Modes (F4 key), Motion blur,
226, 228, 246-247

Toggle Track Output, 85
Toggle Transparency Grid, After Effects,
215,227
Tool tips, viewing toolbar, 15
Toolbars, 15
Tools panel
After Effects, 165
Encore, 331, 335-337
Premiere Pro, 65
Track editing
in Audition, 284-286
clip editing vs., 264
Tracks
multitrack mixing and finishing in
Audition, 278-282
video and audio, in Premiere Pro
Timeline, 85
Transcoding, footage to new location, 47
Transfer Clips to Destination check box,
45, 47
Transfer Modes, After Effects, 226-228,
246-247
Transition elements, screenplay
formatting, 37
Transitions, 125-129
Trapcode Shine effect plug-ins, 136
Trimming clips, with sound bites, 109
Trimming edits
final trimming, 113-114
overview of, 98-99
using Dynamic Timeline Trimming,
99-101
Twirling down, defined, 66
Type tool, titles, 147-149

u

U key, After Effects, 169, 176, 196
Ultra Key effect, 141-146
Uninterrupted Playback, Three-Way Color
Corrector, 298
Upgrade, to Adobe Story Plus, 42
User interface
Adobe After Effects, 163—-165
Adobe Media Encoder, 311
components, 15-17
Encore, 329-332
linking project with media files, 20
Premiere Pro, 63-65



Vv

V key, marking clips, 46
Vector images
creating 3D extrusions in After Effects,
217-220
creating static. See Adobe Illustrator
Mercury Performance System
optimizing, 25
raster images vs., 207
working with, 18
Vectorscope
Color Finesse in After Effects, 300
monitoring color information in Premiere
Pro, 296
Versioning your edit
incrementing After Effects project, 206
overview of, 124-125
preserving rough edit in Premiere Pro,
158-159
Video clips
codecs and extensions, 19
finishing audio mix in Audition, 278-282
working with, 17
Video Copilot, Lens Flare effect, 168
Video tracks, rearranging clips in, 116-117
Visual effects. See motion graphics and visual
effects
Voice-overs
condenser microphones for, 282
recording and editing, 283
Volume, audio waveform displaying, 259-260

w

Warm colors, Three-Way Color Corrector,
297-300
Warp Stabilizer, 150-152
.wav files, audio clips, 18, 279
‘Waveforms, Premiere Pro
color correction using YC Waveform,
295-297
viewing audio, 259-260
Web
authoring DVDs in Adobe Encore, 327
encoding video for, 316-317
ouputting your project as Flash for,
348-349

Welcome screen
Adobe Premiere Pro CS6, 20
Premiere Pro, 60-61
White balancing
color temperature and, 297
defined, 292
Three-Way Color Corrector for, 297-300
Widescreen video (16:9 aspect ratio), 314
Wiggle expression, 245-246
Wipe transition, 129
Work Area bar, Timeline, 86, 152-153
Workflow
chroma keying, 137-140
Dynamic Link speeding, 17
Mercury Performance System
optimizing, 25
opening with other applications, 154
“planning to playback” video production
and, 12-13
Speech to Text, 82
Workspace
for audio in Premiere Pro, 256—258
for color correction in Premiere Pro,
294-295
CS6 Production Premium user
interface, 15
for final output sequence in Premiere Pro,
326-327
for video preview in Audition, 279

Y

YC Waveform
as broadcast-safe, 296
color correction using, 295-297
setting up, 295
using Three-Way Color Corrector
with, 299
YCbCr Parade, monitoring color
information, 296
Yellow bar(s), on Timeline, 152—-153
YouTube, encoding video for, 316—-317

z

Zooming
equal (=) key, into Timeline, 86
minus (-) key, out of Timeline, 91
with Zoom tool, 281
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